Nebraska Department of Education
Nebraska Student and Staff Record System (NSSRS)
www.education.ne.qgov/nssrs

Export File from Data Manager and Import into Microsoft Excel

1. Logon tothe NDE Portal.

Portal Sign In
Login ID:

Password:

, Sign In
, Register

, Forgot Password

EDIT 03/21/2014

Collection Announcements

2007-2008 Annual Financial Report Online System
The 2007-2008 Annual Financial Report Online System is now available. Submissions of the AFR, Poverty Narrative and LEP
Narrative are due by November 1,2008.

2008-2009 NCLB Consolidated Application
The 2008-2009 NCLB Consolidated Application became available Wednesday, September 10, 2008. This application is due to
NDE by Friday, November 7, 2008. For more information, please contact your NCLB Consultant (click on the "Contact Us" link
on the bottom of any NCLB application page).

State Aid Collections Are Open in the CDC

2. Go to the Student & Staff (NSSRS) tab.

Data GMS
Collections

3. Click on the Data Manager.

Available

Activation

Code(s)
Edit/Remove

Student &
Staff (NSSRS)

M-y Forms Viewer 'Tramlvng
Profile Links Videos

Mam

NSRS Data Manager

Available

Edit/Remove

MS5RS Secured Information Website

Available

Edit/Remove

MS5RS Validation

Available

Edit/Remove

Student Unique Identifier (Unig-I1C)

4. Click on the Batch Manager in the left hand column.

Menu
Home

Upload

File Manager
Batch Manager |
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5. Find the batch that has the file you want to download
a. Ifyou do not see the batch you are looking for, you may need to change the
Date From click Filter to find the batches uploaded during a specific time.

Batch Manager

Batches Search ! '

- - Date From: Date To: Batch Status:
Hide from list .. 11082010 [7512/28/2010  [5] Al « [ Fiter ] 22

|:| ¥ Batch ID Batch Type Comments Modified Time Batch Status Data Status Actions
2010-12-07 .'_ C

[] 77811 Data Load 1408 Complete O\B
2010-12-07 .'_ C

[] 77786 Data Load Em Complate O\B

b. If you still do not find your batches you uploaded, you can use the Search feature to search by Batch ID,
Comments, Status, Hidden Batches and Templates. Select the radio button to the left of the desired
search option. Complete the form appropriately; click Search.

Note: Text fields cannot be left blank.

Batch Manager Search

Batches Search
Search By: * Batch ID Comments Status Hidden Batches Template

Batch 1D : h

Search Search All Available Districts

ﬁ Search | *Results returned a limited to a maximum of 200 records.
Mo |

6. Click on the magnifying glass under the Actions Column.
Note: When you use the Search option the magnifying glass will appear in the View Batch column.

Batch Manager

Batches Search

- - Date From: Date To: Batch Status:
file Ao ot o 11082010 [T 121282010 [7H Al ~ [Fitter )2

|:| ¥ Batch ID Batch Type Comments Modified Time Batch Status Data Status Actions
2010-12-07 .— C
[1 77811 Data Load 4,08 Complete O\B
[0 77786 Data Load 20101207 complats @,
12:38 P < h
Batches Search

Search By: Batch ID * Comments Status Hidden Batches Template

Comments : student

Search : Search All Available Districts Search Hidden Batches

Search | *Results returned a limited to a maximum of 200 records.
|

Batch ID Batch Type District Code Comments Modified Date Processing Status ETL Status View Batch

. 2009-08-05 [ h
1 10068 Data Load 99-3939 Student File. 13:25:22.657 Complete @ Q\‘b
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7. Again, click on the magnifying glass under the Actions column.

Batch Files

Data
File ID File Name Uploaded Time Status Actions

ig088 99-5995_STUDENT_200907271031.C5V 2003-08-05

e s = = =

8. Click on the General Information tab.

General Information Validation Information ETL Information
Filename: 99-9939_STUDENT_2003507271031.C5V
Associated Template: STUDENT
File ID: iso0es
Batch ID: 10068
Uploaded Time: 2009-08-03 13:235
Header Record Present: Yes
Delimiter:

Batch Status: Complete

File Status: Complete
Uploaded By: bfbaumfalk
Uploadad Time: 2009-08-05 13:25
Uploadad Via: HTTP

Last Modified By: bfbaumfalk

Last Modified Time: 2009-08-05 13:25
Archived: Nao

Archived Time:

Source File
File Type File Name Records Last Modified Date View File Content
Source File 959-9955_STUDENT_Z00S07271021.C5V 1 2009-08-05 13:25 @

X

9. Click on the View File Content icon.

10. Click on the Download SOURCE File /
Action(s): 1) Download SOURCE File _U e

2) View Clean Fila

11. Click Save As to your computer (Do not select open).
Note: It is important to save the Source file to a location that can be easily found again. If you choose Save the
file will be downloaded to a “defaulted” location, more than likely the “Download” folder. If you choose Save As
you can select where on your computer you would like the file to be saved.
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STEPS TO IMPORTING .csv or .txt file with Microsoft Excel

Now that you have your file downloaded and saved from NSSRS Data Manager, you can now update this data with
corrections and then resubmit. The best way to update this information is to use Microsoft Excel. Do not OPEN this
document in Excel. You will need to IMPORT the file into Excel. When you are done making the corrections you will
need to save the file as a CSV (Comma delimited) (*.csv) using the correct NSSRS naming convention.

Below are separate instructions for each version of Excel on how to IMPORT a .csv file.

A. Microsoft Excel 2007-2013
B. Microsoft Excel 1997-2003
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A. Using Microsoft Excel 2007,2010 and 2013

NOTE: The steps below will work with the 2007-2013 Versions of Excel, the program look and feel may be slightly

different.

1. Open the Excel Program
2. Select the Data tab on the Ribbon at the top on the screen.

NOTE: A blank Excel workbook must be open for the “Data” tab to be available.

(O H9-0-3Z&) - 4' Microsoft Excel

- = X
)

Home  Insert  Pagelayout  Formulag Beview  View  Addns @ - o x
£y From Access -1y Y . [B]ca . 4 & Clear 54| Data Validation ~ | @ Group = #=
S St} S |l i | = =
3 From Web 4 Properties & Reapply [F= Consolidate <& Ungroup - <2
: From Other  Exsting || Refresh Z) sort | Fiter Textto Remove _.
iBFromText  sources~ | Connections || All= =2 Edit Links {7 Advanced | Columns Duplicates 5 What-f Analysis = | & subtotal

Get External Data Connections Sort & Filter Data Tools Outline o
[ Al - £ |

A B e D E F G H [} J K
1 L]
2
3
4
5
6
7
8
9

10

1

12

M 4 » M| Sheetl - Sheet2 , Sheetd  %J [
Ready |

3. In the “Get External Data” group, click From Text.

(Oa Ho-c-S58 )+ Book2 - Microsoft Excel
GEE)
- Home Insert Page Layout Formulas Data Review Add-Ins
(g From Access Iy oy = Conned:ions Al Z " Clear
: =1 | 1 L] et . Z | 7
E}From Web 4 Properties ‘& Reapply
From Other Existing Refrash o Z] sort 7
Sources~ | Connections || All= 2 Edit Links 7 Advanced
Get External Data Connections Sort & Filter
| Al - i |

D E F G

B e
=
@
(o]

4. Browse to find the file (.csv or .txt) and click on the Import button.
Note: If the file does not appear; make sure “all files” is selected from the file drop down.

(] Import Text File “ :‘_ - -- ==

Y e[ » NSSRSFiles v [ %9 W search wssgs Fites 2|
QU e o] o
Organize New folder B~ M @

% Microsoft Office Excel = |#499-9999 STUDENT_20030727103L.CSV |

I 3 Favorites s
[ Recently Changed
B Desktop

"= libraries

Text Files (*.prn;”.bd;™.csv) -
Lo D

File pame: 99-9999 STUDENT_200907271031.C5V  ~

Tools

‘Teﬂ Files [*.im;*.bd;*.cr.u} v'

Text Files (*.prn;*.oet*.csv)
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5. The Text Import Wizard will appear. Select the Delimited radio button. Click Next.

.
Text Import Wizard - Step 1 of 3 [BER

The Text Wizard has determined that your data is Delimited.

If this is correct, choose Next, or choose the data type that best describes your data.
Qriginal data type

Choose the file type that best describes your data:
[ - Characters such as commas or tabs separate each field.

(") Fixed width - Fields are aligned in columns with spaces between each field.

Startimport atrow: |1

Preview of file C:\Users\Aimee\Desktop\NSSRS Files\99-9999_STUDENT_200307271031.C5V.

EISTRICT CCDE,LOCATION CODE, SCHOOL YERR DATE, STUDENT ID,SOCIAL SECURITY |
[#5-9593,001,2010-06-30, 4948002518 11

2] File origin: 437 : OEM United States E

1

2[35-5535,001,2010-06-30, 4348002518, ,,,,,
3

4

5

<

e 1995-04-28,F,, ., \0iris W, [

/ -

6. If the file you are importing is comma-delimited (*.csv) un-check the Tab checkbox and

check the Comma checkbox. Click Next.

NOTE: The data in this window should display in columns if the correct delimiter (tab or comma) is selected.

-

Text Import Wizard - Step 2 of 3

? | R

below.

Delimiters

[[1ab
# Comma

[[] space
[T other:

Text gualifier:

Data preview

This screen lets you set the delimiters your data contains. You can see how your textis affected in the preview

] Semicalon [ Treat consecutive delimiters as one

-]

PISTRICT_CODE
[F3-3333 o1

< [l

TICH CODE [SCHOOL_YEAR DATE
010-06-30 (1948002518 ]

[FTUDENT ID [SOCIAL SECURITY ] &

/,'

P~
Cancel ][ < Back ‘ Next > ? Finish
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7. Select all of the data in the Data preview window by clicking in the first column, scroll to the last column, holding
down the SHIFT key on your keyboard and click in the last column.

Text Import Wizard - Step 3 of 3 P o=

This screen lets you select each column and set the Data Format.
Column data format
@ General
Text
Date:

‘General canverts numeric values to numbers, date values to dates, and al

remaining values to text.
Advanced...

MDY

Do not impart column (skip)

Data preview
snezzl enersl enersl
E [ECHOOL YEAR DATE STUDENT ID SOCIAL SECURITY NUY =
o10-06-30 4548002518
L3
\ Cancel \ \ < Back | [ Einish ]

Text Import Wizard - Step 3 of 3

This screen lets you select each column and set the Data Format.
Column data format:
@ General
Text
Date:

‘General converts numeric values to numbers, date values to dates, and all

remaining values to text.
MDY

Do not impart column (skip)

Data preview

8. Change the data format to text by selecting the Text radio button. Click the Finish button.

.

Text Import Wizard - Step 3 of 3

P &

This screen lets you select each column and set the Data Format.
Column data format

General

* @ Text

Date:

remaining values to text.
MDY

Do not import column (skip)

Data preview

'General' converts numeric values to numbers, date values to dates, and all

9. The “Existing worksheet:” can be left selected as the worksheet the data will be imported into. Select OK.

il N
Import Data ? 28
Where do you want to put the data?
@ Existing worksheet:
—$AS1 %
Mew worksheet
| Properties... ‘D Cancel
L A
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Tip: To Replace Column Headings with numbers instead of letters (Optional):

Microsoft 2007. Click the “Office” button =» Options = Formulas = R1C1 Reference Style

Microsoft 2010 and 2013 Click the “File” Tab =» Options =» Formulas = R1C1 Reference Style

S

|:| Enable jterative cal

Maximum Iteration:

Maximum Change:

Ecel D pipns

Popular E o| . .

ﬁ Change options related to formula calculation, performance, and errar har

[Formuss |

Proofing ‘Calculation options

Save Workbook Calculation(i

@ Automatic

Advanced () Automatic except for data tables

Customize O Manual

Add-Ins

Trust Center ‘Working with formulas

Resources B1C1 reference style (i

Formula AutoComplete (&
Use table names in formulas
Use GetPivotData functions for PivotTable references

N ® NEBRASKA DEPARTMENT ¢t EDUCATION

Page | 8



Export File in Data Manager and Import into Microsoft Excel | 03/21/2014

Saving Corrections
Once you have the file imported into Excel you can review, make corrections and/or delete records.

(Don’t forget to update your SIS). Follow the steps below to save the file as a .csv (comma separated value) in order to
upload to NSSRS Data Manager.

1. Click on File (in 2007 click on the “Office Button”) choose Save As from the menu

.i. Home 1
|l save

Save As

= Open
l__? Close
2. Within the Save As window choose the folder/location you want to save the file.
3. Click on the dropdown arrow at the end of the Save As Type option and choose “CSV (comma delimited)”
Bookl.csv -
sV (comma delimited) () -

Excel Workbook (“lsx)

Excel Macro-Enabled Workbook (*.xlsm)

Excel Binary Workbook (*sh)

Excel 97-2003 Workbook (*xls)

XML Data (*xml)

Single File Web Page (*.mht;*.mhtmi)

Weh Page (htm:" html)

Excel Template (*dt)

Excel Macro-Enabled Template (*.xitm)

Excel 97-2003 Template (*t)

Text (Tab delimited) (".t¢)

Unicode Text (*.tct)

XML Spreadsheet 2003 (*axmi)
Microsoft Excel 5.0/95 Workbook (*.xls)

w €5V {Comma delimited) (*.csv)

Formatted Text (Space delimited) (*prn}

Text (Macintosh) (*.b)

Text (MS-DOS) ()

CSV (Macintosh) (*.csv)

CSV (MS-DOS) (*.csv)

DIF (Data Interchange Format) (*.dif)

SVLK (Symbolic Link) (*s1k)

Excel Add-In (*.xlam)

Excel 97-2003 Add-In (*:da)

S Dovument (aps
OpenDocument Spreadsheek (*ods)

4, In the File Name field type the appropriate file specific naming convention (see below)
File Specification File Naming Convention Pattern
Assessment Fact H#-H##H#_assessment_fact_YYYYMMDDHHMM.xxx
School Enrollment H#-##Ht#_school_enroll_YYYYMMDDHHMM.xxx
Special Education Snapshot H#-##H#_special_ed_snap_YYYYMMDDHHMM.xxx
Staff Demographics H#-H#H#_staff_demographics.zzz
Staff Position Assignments H#-H#H#_staff_position_assignments.zzz
Student Hi-H##_student_YYYYMMDDHHMM.xxx
Student Grades Hi-H##H##_stud_grades_YYYYMMDDHHMM.xxx
Student Snapshot H#-H##H#_stud_snapshot_YYYYMMDDHHMM.xxx
Student Summary Attendance Hi-#H## stud_att_sum_YYYYMMDDHHMM.xxx
Post School Survey H#-H#Ht#_post_school_survey_YYYYMMDDHHMM.xxx
Programs Fact Hit-#t#H#_programs_fact_YYYYMMDDHHMM.xxx
Title | Programs Hit-#i#H#_titlel_programs_YYYYMMDDHHMM.xxx

Where: ##-#### is the NDE-assigned District Code YYYYMMDDHHMM is a date and time stamp

5. Click Save
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6. You will get two warning messages from Excel, Click OK and YE
PMicmstt Excel ﬂ‘

The selected file type does not support workbooks that contain multiple sheets.

_L «To save only the active sheet, dick OK.
«To save all sheets, save them individually usj ifferent file name for each, or choose a file type that supports multiple sheets,

=

Microsoft Excel

93-8953_STUDENT _200307271031.C5V may contain features that are not compatible with CSV (Comma delimited). Do you want to keep the
__ workbookin this format?
)+ To keep this format, which leaves out any incompatible features, dlick Yes.
+Ta preserve the features, cick No, Then save a copy in the latest Excel format.

+To see what might be lost, cick Help.
m—\ e Yw ] [
N —

7. Now you can close the Excel file. It will ask if you want to save the file click Don’t Save

Microsoft Excel

Ay
| . Do you want to save the changes you made to
'99-5999_STUDENT_200907271031.C5V?

e

e ——

Now you can upload the corrected file to NSSRS Data Manager.
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B. Using Microsoft Excel 1998-2003

1. Open the Excel Program

2. Select the Data tab on the Ribbon at the top on the screen. Get External Data =» Import Text File.
NOTE: A blank Excel workbook must be open for the “Data” menu to be available.

3. Inthe “Get External Data” group, click Import Text File.

4. Browse to find the file (.csv or .txt) and click Open. Be sure to look for All files.
5. The Delimited radial button should be selected. Click Next.

Text Import Wizard - Step 1 of 3

The Text Wizard has determined that your data is Delimited.
If this is correct, choose Next, or choose the Data Type that best describes your data.
Original data type
Choose the file type that best describes your data:
# ® Delimited - Characters such as commas or tabs separate each field.

O Fixed width - Fields are aligned in columns with spaces between each field.

Start import at row: | 1 \+ File origin: | Macintosh D

Preview of file Secure ltupload07 txt.

T

TH 18/89,/2006 13:35:49 1111111111 1 delimiter-axa3 m
ID @31 19-8A5E Ercbec MaGyver Steven M 18/18/1998 G2 197031 WH 4534377083 193783 2807
ID @31 13-8@SE Poprocki Shelby Margerite F @3/19/1998 @2 197834 WH 7513785457 10-@703 2f

ID 831 13-8@SE Delong Destiny Veronica F @3/15/1998 @3 197835 WH 3661523163 198783 203|
ID 831 13-8@SE Movolny Alyssa Michole F @9/22/1997 @3 197836 WH 6471282125 19-8783 2087
v

ID 831 13-0@S8 Paprocki Jokub Michoel M @5/12/1998 @3 197037 WH 5SB20814553 19-8783 €3

( Cancel ) < Back @)

6. If the file you are importing is comma-delimited (*.csv) un-check the Tab checkbox and
check the Comma checkbox. Click Next.

EIEET

Text Import Wizard - Step 2 of 3

This seen lets you set the delimiters your data contains. You can see how your text is
affectel in the preview below.

Delirfiters ] Treat consecutive delimiters as one
— . m
# Tab ! Semicolon ] Comma Text qualifier: [ =

[l space [_| Other:

Data preview

18,/93,/2096 [L3:35:49 [1111111111 1 delimiter=8X83
D i 19-8858 [Brabec iyver |Steven 18/1@/1038 {32
D il 19-8858 [Poprocki  [Shelby rgerite F 19,1998 a2
D i 19-8358 [DeLong Destiny [Veronica F 3/15/1998 (33
D L 13-8858 [Novotmy lyssa [ichole F 2271397 B3
D L 19-B858 [Poprocki  [Jakub ichoel 5/12/1998 33

( Cancel ) ( < Back @ Finish )

NOTE: The data in this window should display in columns if the correct delimiter (tab or comma) is selected.
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7. Select all of the data in the Data preview window by clicking in the first column, scroll to the last column, holding
down the SHIFT key and click in the last column.
8. Change the data format to text by selecting the Text radial button. Click the Finish button then Save.

Text Import Wizard - Step 3 of 3

This screen lets you select each column and Column data format
set the Data Format. —~

UG
'General' converts numeric values to numbers, @ Text

date values to dates, and all remaining values
to text. O pate: [ MDY % ]

[ Advanced b Y :, Do not import celumn (Skip)

Data preview

x [+ [Tex [T [Tee £
/00,2006 13:35:49 1111111111 1 dalimiber=009
MoGyver Steven 19/18/1998 &2
Shelby Margerite 29/19/1998 B2

Destiny Veranmica 83/15/1998 &3
Alyssa Michole 89/22/1997 &3
Jakub  Michael 85/12/1988 @3

(" cancel ) ( <Back ) Next >

Follow Step 9 from previous instructions for the later versions of Microsoft Excel to complete the import.

Tip for Microsoft Excel 1998-2003: To replace Column Headings with numbers instead of letters (Optional):

Select Tools 2 Options. On the General tab, check R1C1 reference style.

P Preferences

View Semngs/

L]
® save # RICI reference style [ Prompt for workbook properties
® Calculation
® Edit ) Provide feedback with sound
# ] Confirm launching applications in Open and New
® Compatibility =
® Custom Lists # Recently used file list: 4| (2] Entries
® Chart = P
® Color Measurement units: | Inches & ( Web Options... )
® Security
® Error Checking <
Sheets in new workbook: 3 -
Standard font: Verdana @ Size: 10 @
- ~
Default file location: ( Select... )
————
Alternate startup file location: ( select... )
o
User name: Sue Oppliger

E Show Project Gallery at startup

Description of preference

R1C1 reference style

Changes the reference style of row and column headings and cell references from Al style to RLC1 style. In ALl
style, columns are labeled alphabetically, and rows are labeled numerically. In R1C1 style, both columns and rows
are labeled numerically.

( Cancel |

oD
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